
   
 
Version 13.0.8 

Software Update Details 

Release Date 01-July-2010 

Problem Fixes in Version 13.0.8 : 01-July-2010 
 
Check For Updates 
o Automatic checking for program updates was not always working if your Internet connection was made through a 

proxy server. 
 
Component Wizard 
o No pads were being displayed in the Component Wizard. 
 
Import BoardMaker 
o BoardMaker design files with more that 1023 text items would not import. 
 
Import Eagle 
o Octagonal pads were being imported as round. 
o Some pin numbers in PCB designs were being imported without assigning them to a layer. 
o Component areas in PCB designs were sometimes being assigned to the top electrical layer. 
 
Import Gerber 
o Some sets of Gerber files with negative coordinates (‘centre zero’ coordinate system) would not import through 

the Intelligent Gerber Import option. 
 
Move 
o Selecting and moving multiple groups of items didn’t move all the items in the second and subsequent groups. 
 
Plotting 
o The default settings for solder paste plots included drilled pads which are normally excluded from paste plots. 
 

Program Changes in Version 13.0.7 : 21-May-2010 
 
Add Spiral 
o When adding a spiral track, the Aspect Ratio was applied to the first turn in the middle of the spiral, which meant 

that it was not easy to define a spiral with a particular aspect ratio on the outermost turn. This has been changed 
by the addition of a checkbox on the Add Spiral dialog that allows you to specify whether the aspect ratio should 
be applied to the inner or the outer turn. 

 

Problem Fixes in Version 13.0.7 : 21-May-2010 
 
Back Annotation 
o Some components were being mistakenly identified as ‘Schematic Only’ components, which prevented the Back 

Annotation from being properly applied. 
 
Component Edit 
o Attempting to assign pin numbers after adding a gate and a package could cause the application to quit. 
o Deleting one gate from a multi-gate component was actually deleting two gates. 
o On some Vista and Windows 7 systems, inability to create the component edit ‘grid’ rendered the component 

editing inoperable. 
 
Databook 
o When using libraries stored in more than one folder, the Databook would not always display the libraries from the 

correct folder. 
o First-time software installation did not initialise some of the folder names used by Databook to the correct place. 
 
Design Rule Check 

o Some spacing violations for track segments using a wider width than the rest of the track were not being 
detected. 

 
DXF Import 
o Some forms of DXF text were causing the DXF import to fail, then causing the application to quit. 
 
Edit Arc 
o Small inaccuracy in calculating arc positions meant that one particular shape had a straight line that could not be 

converted to an arc. 
 
Gerber Output 
o One specific design had a via covered by a copper shape when it should have been clear. 
 



N. C. Drill Output 
o Excellon files containing a mixture of slots and drills were not being correctly interpreted on some CAM systems 

when the drill entries were interspersed with slot information. 
 
Output Netlist 
o When attempting to write a netlist from a multi-page Project the application would sometimes quit. 
 
Output ODB++ 
o Bars above barred text was not in the correct place if the text was rotated and/or mirrored. 
o One specific design was causing the application to quit when attempting to generate ODB++ data. 
 
Pour Copper 
o One specific design refused to pour. 
 
Support Information 
o The registry settings written to the report did not include ‘binary’ data sections. 

 

Problem Fixes in Version 13.0.6 : 25-Feb-2010 
 
Component Wizard 
o It was sometimes not possible to create valid schematic-only components due to incorrect pin number messages. 
 
DXF Import 
o Was unable to read DXF files that contained block call transformations using negative scales. 
o Imported drill holes became shapes with a massive line width. 
 
Eagle import 
o Component names were being switched to layer [All]. 
o Did not allow you to use no technology file when opening an Eagle file. 
 
GenCAD Output 
o Outputting padstacks that were zero sized would cause the application to quit. 

 
Integrity Check 
o Was listing some attribute differences, but did not explain that they were caused by component version 

mismatches and therefore not fixable with Forward Design Change. Messages have now been improved. 
 

ODB++ 
o Incorrect poured shape cutouts were being output for a specific design. 
o On another design some poured shape cutouts were missing from the top side. 
 
OrCAD import 
o If some errors were found on importing components, no nets were imported at all. 
 
PCB Symbol Wizard 
o The diagram on the Pads page for the SOD type had PL and PW incorrectly indicated. 
 
PDF Plot 
o Missing fonts were causing PDF plots to fail. 
 
Pour 

o A specific design failed to pour completely. 
o Application quit whilst pouring top copper due to it containing an invalid error marker that had no layer. 
 
Properties 
o Could not split a component across sheets if a gate name had more than one letter. 
o When splitting connected components across sheets it did not properly disconnect the gates that were moved to 

the bin. 
 
ProRouter 
o Was creating several tracks and vias over each other when the design contained oval pads with their length equal 

to their width. 
 
 

Problem Fixes in Version 13.0.5 : 08-Dec-2009 
 
Design Revision Analyser 
o Attempting to compare two projects in two folders when the files in each project had the same name would cause 

the application to quit. 

 



Gerber Output 
o In one specific design, splitting of a particular poured copper shape to produce the corresponding set of shapes 

without cutouts as required in Gerber data resulted in three vias being covered with copper instead of being left 
clear. 

o One specific design had a misplaced arc on a copper boundary on the Gerber output, visible within the Gerber file 
where the arc tapered towards the adjacent pad. 

 
 

Program Changes in Version 13.0.4 : 27-Nov-2009 
 
Open 
o In Easy-PC version 12 and earlier, opening a file from Windows Explorer would open that file in its own instance of 

the application. In version 13 this behaviour was changed (in response to a number of customer requests) to 
follow the more usual convention of opening in the existing application instance. 
 
In recognition of the fact that the previous behaviour may still be preferred by some users, a new switch in the 
Preferences dialog now allows you to choose whether to revert to the previous behaviour of opening each file in its 
own instance of the application. 

 
Problem Fixes in Version 13.0.4 : 27-Nov-2009 
 
3D View 
o Using the 3Dpackage value on a specific component to over-ride the default package assignment based on the 

footprint name was not actually having any effect. You can now name either a specific package to use in place of 
the one derived from the footprint name, or leave the value blank to prevent it from looking for a package at all 
and hence to ‘suppress’ the component body from appearing in the 3D view at all. 

 
Add Shape 
o It was not possible to Change Style while adding rectangular or circular shapes, the style change was just being 

ignored. 
 
Add To Net 
o When creating a new net in Add To Net, the dialog was not preselecting the default Net Class. 
 
Change Layer 
o Changing track layer onto a surface-mounted pad was introducing a via on top of the pad. 
 
Component Edit 
o After pasting items such as netnames into the Component Edit grid, the whole grid would redraw and scroll back 

to the first line of the grid, requiring you to go back and find your place each time. 
 
Component Values 
o When the Component Values ‘spreadsheet’ editor, left and right cursor keys would not work. 
 
Component Wizard 
o It was not possible to create valid Schematic-only components using the Wizard. 
 
Cross Probe 
o When using Cross Probe from a PCB design in Dual Screen mode, it was not always opening the required 

Schematic design. 
 
Calculators 
o The wrong unit scale was being used for Inductance in the Stripline calculator. 
 
Colour Files 
o The settings for Value Positions was not being written out to a colour file. 
 
Design Revision Analysis 
o If two projects were compared, the second project was not closed properly afterwards, causing subsequent 

attempts to compare designs to fail. 
o If the report was written to HTML, the resulting file was instead being given a .TXT file extension and thus opened 

in Notepad instead of your web browser. 
o If a PCB design was accidentally selected to compare against a project, the application would quit. 
 
Design Rule Check 
o When adding ‘Single Pin Net’ errors, it was not checking to see if those errors already existed as Accepted Errors. 
o When adding errors for tracks outside all keepin areas, the position for those error markers was completely 

random. 
 
Find 
o Using the Find Library Item dialog to find symbols from the New Component after previously using it to Find 

Components could display an error message about missing value names even though the value controls were not 
visible on the dialog. 



 
GenCAD Output 
o Some padstacks were incorrect or had duplicate names, causing some GenCAD files to produce pads on the wrong 

side of the board. 
 
Library 
o On the Components page of the Library dialog, where a component had multiple packages then the PCB preview 

was sometimes showing the wrong package picture if you selected the PCB symbol name in the list. 
 
Menus 
o The context menu displayed on right-clicking on Error markers or Bitmaps included some commands not valid for 

these items. 
 
Move 
o If the current selection contained nothing but Error markers, dragging them would give the appearance of being in 

‘Place mode’ but nothing was actually moving. 

 
ODB++ Output 
o Copper shapes were not being included for one particular PCB design. 
 
Open 
o Double-clicking on a design in Windows Explorer was launching the application but also loading previously open 

designs. 
o Opening a file from Windows Explorer when Easy-PC was already open was always opening the selected design in 

that first instance of the application. A new switch in the Preferences dialog now allows you to choose whether to 
revert to the previous behaviour of opening each file in its own instance of the application. 

 
PDF Plot 
o Dotted and dashed lines were always being output as solid lines. 
o When outputting all plots to a single combined file, the filename used was based simply on the design name, 

which frequently meant that the Schematic PDF would overwrite the PCB one, and vice versa. The design ‘type’ is 
now included as part of the PDF file name to separate the two files. 

 
Plotting and printing 
o Hatch-filled shapes in footprints were being plotted as plain shapes without their hatching. This problem affected 

all the plotting outputs (Gerber, Pen, PDF and Windows plots). 
o If ‘Step & Repeat’ settings were changed, this did not cause the current plot job to be marked as modified, thus 

allowing the Plotting dialog to be closed without prompting to save the plot job. 
o Net Guard Spacing was not always being taken into account when plotting a full powerplane, sometimes resulting 

in the wrong gaps between the plane and other items. 
 
Pour 
o Two specific designs had issues with very small track segments that caused Pour to produce incorrect results. 
 
Properties 
o Opening the Properties dialog when a mixture of surface-mount and through-board pads was selected was causing 

the application to quit. 
o It was possible to change a cutout or a closed shape with cutouts into an open shape, using Properties or by right-

click and unticking ‘Closed’ on the context menu. 
 
Select 
o It was possible to select a bitmap even when the layer to which the bitmap was assigned had been turned off in 

the Display dialog. This meant that bitmaps could be accidentally moved when they were not visible. 
 
Status Bar 
o The coordinates shown on the Status Bar for the position of the selected item did not take into account the 

System Origin, instead they were always shown relative to the lower left corner of the working area. 
 

Problem Fixes in Version 13.0.3 : 21-Sep-2009 
 
Cursors 
o When using the large cross-hair cursor, the cursor could become virtually invisible if you ‘slid off’ a menu without 

choosing an option from the menu. 
 
Layers 
o In the Layers bar, ticking a checkbox to display a layer would draw the layer but immediately turn the checkbox 

back off again. 
 
Menus 
o The menu option for ‘Change Net Colour’ was included on right-mouse context menus twice. 
 
N.C.Drill 
o When writing milling command M15, lack of newline after this command could cause some older CAM software to 

mis-read the resulting Excellon data file. 



 
Plotting and Printing 
o Enabling the [Board Outline] pseudo-layer on the Layers tab of the Plotting dialog would cause the application to 

quit if the Plot Preview was enabled. 
 

Problem Fixes in Version 13.0.2 : 10-Sep-2009 
 
Add Text 
o Problems with undefined or only partly-defined default styles for text could cause the application to quit when 

attempting to insert new text items. 
 
Component Edit 
o Pin numbers on component pins could not be added/set using lower case letters. 
 
Component Values 
o Pressing the Enter key on the keyboard when in the spreadsheet-style Component Values dialog would generally 

close the Component Values dialog rather than behave like a ‘normal’ spreadsheet and simply move down to the 
next row. 

o No shortcut (alt+key) settings were defined for the buttons on this dialog. 
 
Cross Probe 
o Some elements of cross probing were not working when working in Dual Screen mode, depending on direction of 

probing and whether project files were involved. 
 
Design Rule Check 
o Via-in-pad checking could report an error for a blind/buried via being inside a pad even though the layerspan of 

the via didn’t reach the pad. 
o No menu command was available to allow DRC settings to be created/updated in a PCB Technology file. Note that 

the PCB Technology menu set may need ‘resetting’ using ‘Customise’ for existing installations. 
 
Design Technology 
o Styles or other technology items created on one page of the dialog were not available for use on other pages until 

the dialog had been closed and re-opened. 
o DRC settings were not being copied to new PCB design created from a Technology file. 
o Cursor keys could not be used to move around the ‘grid’ when editing styles etc. 
 
Display 
o Entries on dialog for ‘Values’ altered to avoid confusion with ‘Symbol Text’. 
 
Drawing 
o Selecting a whole filled shape was only drawing its outline as selected, leaving the filling drawn in the original 

colour. 
 
Dual Screen 
o First-time startup in Dual Screen mode could put both PCB and Schematic instances on top of each other system 

configuration placed the primary monitor to the right of the secondary monitor. 
 
Duplicate 
o Components which were defined to have more than one gate could not be duplicated in a PCB. 

 
DXF Output 
o Unable to read DXF files from Version 13 into some software packages even for designs that generated acceptable 

DXF files from Version 12. 
 
Forward Design Changes 
o If Forward Design Changes was attempted on a schematic with no corresponding PCB, the program would quit 

after closing the warning message box. 
 
GenCAD Output 
o Square pads were not being output at the correct size. 
o Unnamed alternate padstyles on components were not being included in the output. 
o Copper shapes can confuse some CAM programs so the dialog now allows copper to be omitted. 
 
Goto 
o Goto Next/Previous error was always changing the view to centre the Error marker, regardless of the Goto Bar 

setting for ‘Centre View on Found Item’. 
 
Grid 
o Redrawing the picture when moving an item would cause the lines/dots of the screen grid to be drawn in the 

‘complement’ of the correct colour, most noticeable when displaying the grid as lines. 
 
Layers 
o Auto-numbering of electrical layers in Layer drop-down lists (e.g. in Change Layer and Change Track Layer 

dialogs) made it hard to select non-electrical layers or to alter an incorrect selection. 



o There was no setting on Preferences to turn off the auto-numbering of electrical layers in Layer drop-down lists. 
 
Library Manager 
o Renaming a library item was reselecting the item under its new name but not updating the preview. 
 
Next/Previous Error 
o These commands were including Accepted Errors when they should only be stepping through the ‘normal’ errors in 

the design. 
 
ODB++ 
o Underlines on rotated text items were not being output in the correct position. 
 
Open 
o Opening design files from Windows Explorer would sometimes open the wrong project file, or open a new instance 

of the application. 
 

Pad Styles 
o Changing the shape of the drill hole in Edit Pad Style from round to non-round was not displaying/enabling the 

length controls unless the pad itself used a padshape with a length. 
 
PCB Symbol Wizard 
o Selecting to use a technology file in the PCB Symbol Wizard was not disabling the explicit units and precision 

controls, giving a misleading impression of which units would actually be used. 
 
PDF Plot 
o TrueType text was not being rotated along with the rest of the plot if the plot was rotated by 90 degrees. 
 
Plotting 
o The Plot Preview on the Plotting & Printing dialog would only show the first enabled layer from the Layers tab, 

would not display vias, and would frequently lag behind or not match the various checkboxes on the Settings tab. 
 
Pour Copper 
o Specific designs containing overlapping or nested board outlines were causing incorrect pour results. 
 
Project Files 
o Some project files containing dots in the filenames could not be opened. 
 
Properties 
o Reloading a bitmap item in Properties would not always draw the new bitmap until the design was closed and re-

opened. 
 
ProRouter 
o Some designs were not restoring their routing results. 
 
Reports 
o Reports being written to CSV were being given a .TXT file extension instead of .CSV. 
 
Save 
o When saving design files as part of the process in Forward Design Changes, Integrity Check or Back Annotation, 

no backup copy of the existing design was being kept. 
 
Setup 
o A missing registry value meant that sometimes a correctly installed Easy-PC program would ‘forget’ the path to its 

library files on the first time the program was run up. 
 
Support 
o The Support Information dialog was incorrectly reporting Windows Vista as Windows 2000. 
 
Technology Files Dialog 
o Did not allow transfer of DRC checking/signoff settings. 
o Showed Net Classes on ‘Misc’ page as well as on their own page. 

o Not all spacing values/rules could be transferred. 
 
Tooltips 
o These would frequently stop working until the mouse was clicked in the design area. 
 
Translate to PCB 
o If the selected PCB technology file contained a board outline and components were not being translated into the 

Component Bin, the new components were not being arranged relative to that board outline but instead were 
being stacked near the lower left corner of the working area. 

 
Update Component 
o Updating a component for which more than one package already exists in the design could cause the design to 

become corrupt and potentially unreadable. 



 

Problem Fixes in Version 13.0.1 : 04-Aug-2009 
 
Bitmaps 
o Right-clicking on a Bitmap would cause the application to quit. 
 
Easy-PC DOS import 
o Attempting to open most Easy-PC DOS design files was simply producing an error message. 
 
Forward Design Changes 
o When forwarding changes in designs using multiply-mapped component pins, too many changes or the wrong 

changes were being made to the PCB design. 
 
Integrity Check 
o When using Dual-Screen mode with the relevant designs open in the two instances, Integrity Check, Forward 

Design Changes and Back Annotation would sometimes get confused over access to the design files and either fail 
with an error or simply not do anything. 

 
Menus 
o The Help menu option ‘Online Manuals’ was not being automatically inserted into the menu when upgrading to 

version 13 from an earlier version. 
o The Pour Copper menu option to re-pour all areas was greyed out if nothing was selected. 
 
Open 
o Opening files from the Windows Explorer was opening them in a new instance of the application each time, 

instead of ‘handing off’ to an already running application if there was one. This issue is fixed automatically during 
Patch installation by applying a small registry fix (adding/setting values for Easy-PC files under 
HKEY_CLASSES_ROOT). 

 
Optional Features 
o The default folder offered when attempting to locate third-party applications such as Specctra was not being 

initialised to the ‘Program Files’ location. 
 
Paste 
o Pasting schematic data into a design containing an invalid component definition was causing the application to 

quit. 
 
PDF Plot 

o TrueType text was not being rotated if the plot itself was rotated by 90 degrees. 
 
Project Files 
o Creating a new project file in the PCB instance when running in dual screen mode was prompting twice for the 

new project filename (once in each instance). 
 
Properties 
o The Hatched checkbox on Shape Properties for a Copper Pour Area was in the same place as the Net name on the 

dialog, so it was being obscured. 
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